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Gemini Help

Welcome to the Optec Gemini Help
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Revisions to this Help document

Rev 1.00 - 2015/05/07 initial release.  

Rev 1.01 - 2015/11/03 Minor updates

Rev 1.02 - 2016/02/09 Updated to software version 1.0.3.



5 / 81



6 / 81

Setup

Chapter 1: Gemini Hub Setup

About- Capabilities of the Gemini hub

License - The End-User License Agreement for the Gemini Commander software and
Gemini control website

 
Quick Start - A digital copy of the paper Quick-Start Guide that is included with the purchase
of every Gemini focuser hub

Software Installation - How to install Gemini Commander on your system
 

Connecting To Your Gemini - How to connect your hub to your computer using
Gemini Commander

Completing The Configuration - How to complete the Gemini Commander
configuration process for your hub

 
Temperature Coefficients - How to use Gemini Commander to automatically
calculate and store temperature compensation coefficients.

Configuring Software - How to configure software on your computer to control the Gemini
 

 Webpage Ethernet Connection - Configuring browser-based control with an Ethernet
connection

 
 Webpage Wi-Fi Connection - Configuring browser-based control with a Wi-Fi
connection

 
Direct Serial Connection - Configuring direct serial control with a serial terminal
application

Uninstalling Software - How to remove Gemini Commander from your system
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About

Section 1.1 - About The Gemini

What Is Gemini?

The Gemini is a Focusing Rotator in a single compact package. The focuser has a full half inch
(12.7 mm) of travel. The rotator has a full three hundred and sixty degrees of rotation. The whole
package fits in a 2.75 inch (seventy mm) package when the focuser is fully extended. Both the
Focuser and the Rotator are controlled from the same hub.

The Ever-Reliable Serial Port

Everyone knows that the serial port is almost extinct, right?   In truth, the serial port is still the
most reliable standard communications protocol available and is used in several industries and
applications, including observatory control. The RS-232 serial protocol is simple to implement,
capable of communication over great distances and very reliable when used properly. To allow
the hobbyist to easily write software for control of the focuser and for firmware upgrades, the
Gemini system includes an RS-232 interface as standard. 

Using Optec's Serial-USB communications cable, users can easily connect the Gemini
controller to any modern PC even when no DB-9 serial port is available.  The Serial-USB cable
includes an RJ-12 plug on the controller end and terminates in a USB converter on the PC end. 
The original TCF-S focuser has enjoyed overwhelming success with these new
communications cables.   Additionally, with the Serial-USB cable the 5 meter distance limitation
of USB 2.0 is negated.  The Gemini controller includes a single 6-ft.long Serial-USB cable, but
much longer cables, up to 50 meters in length, are available from Optec.

Wired Ethernet Connectivity

Gemini also supports Ethernet connections, allowing for large distances and easy remote
control.  

Optional WiFi Connectivity

With the explosion of mobile devices capable of direct network communications, the Gemini
system includes easy mobile access through iPhones, Android OS devices, and any other
device with an Internet browser. With the purchase of the optional WiFi control board,
connectivity to a Gemini is a snap.  Now observers, astrophotographers, and astronomy
enthusiasts can completely eliminate the hassle of computer control cables by connecting to the
Gemini over a wireless network.  Focusing can be accomplished without ever touching your
telescope eliminating vibrations and thermal effects. 

ASCOM Compatibility

The Gemini software package includes an ASCOM-compatible driver for both the Focuser and
the Rotator. Therefore, the Gemini hub is usable with any ASCOM-compliant software.  Acting
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as an ASCOM Local Server, the Gemini requires ASCOM Platform 6.1 or higher for use.  

Please Note: This manual documents only the Gemini focuser hub and control software. Refer
to the ASCOM Standards website (www.ascom-standards.org) for platform downloads and
documentation.   

www.ascom-standards.org
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License

Section 1.2 - Gemini Software Warranty

By installing and/or using Gemini Control software, you agree to Optec's license and warranty
terms below.

 GEMINI COMMANDER, GEMINI CONTROL WEBSITE, AND THESE INFORMATIONAL
MATERIALS ARE PROVIDED "AS-IS": NEITHER  OPTEC, INC., ITS AUTHORS, NOR ITS
SUPPLIERS MAKES ANY WARRANTY, EXPRESS OR IMPLIED WITH RESPECT TO THE
CONTENT OF THESE MATERIALS OR THE ACCURACY OF THE GEMINI COMMANDER/
CONTROL WEBSITE  PRODUCTS, INCLUDING, WITHOUT LIMITATION, THE IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
BECAUSE SOME STATES / JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF IMPLIED
WARRANTIES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

IN NO EVENT SHALL OPTEC, INC., THE AUTHOR, OR ITS SUPPLIERS BE LIABLE FOR
ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR
INABILITY TO USE THESE  PRODUCTS, EVEN IF OPTEC, INC., HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
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Quick Start

Section 1.3 - Gemini Quick-Start Guide

If you are now the proud owner of a new Gemini Focusing Rotator, congratulations! You are on
the cutting edge of Astronomical technology! 

We invite you to use this quick-start guide to get a fast introduction to the installation, connection,
and configuration process that you will need to go through to get your Gemini up and running.
However, we also suggest that you read the full Gemini Technical Manual in order to gain a more
complete understanding of the advanced features and multiple connection methods that will help
you to get the most out of your Gemini.

Software Installation - How to install Gemini Commander on your system
 

Connecting To Your Gemini - How to connect your focuser hub to your computer using
Gemini Commander

 
Temperature Coefficients - How to use Gemini Commander to automatically calculate and
store temperature compensation coefficients

Completing The Configuration - How to complete the Gemini Commander configuration
process for your focuser hub
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Software Installation

Section 1.3.1 - Gemini Commander Installation Instructions

NOTICE: Make sure that you have connected the hub's focuser port to the Gemini's focuser port
and the hub's rotator port to the Gemini's rotator port. Although it is difficult to damage the Gemini
by switching the lines it is best to avoid this problem.

Installing Gemini Commander

To install the Gemini Commander control software and ASCOM Gemini drivers, please follow
these steps:

Review the System Requirements to verify that your system is capable of running Gemini
Commander. If you are reading this document on a Windows machine it is almost certain
that your computer far exceeds the minimum requirements.

Obtain the latest version of Gemini Commander installer from the Downloads page on the
Optec website. If you do not have an Internet connection, the release version of Gemini
Commander is available on the CD included with the hub. You can also download the
program on another computer and transfer the installer to your control computer.

Double-click the installer file to run it.

http://www.optecinc.com/astronomy/downloads/index.htm


12 / 81

Follow the instructions in the installer to complete the installation.

 
Congratulations! Your Gemini Commander software is installed and ready for configuring with
your focuser system. 
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Opening Gemini Commander

For first-time use, Gemini Commander will open when the installation is finished unless you
specified otherwise. 

For later use, you can open Gemini Commander by picking one of the following options:

Double-click the shortcut for Gemini Commander that the installer creates on your
Desktop.

-OR-

If you are using Windows Vista or Windows 7, go to the Start menu, then search for Gemini
Commander in the search bar.

-OR-

Go to the Start menu, and choose All programs. Click the Optec folder, click the Gemini
folder, and click the Gemini Commander shortcut that appears.

-OR-



14 / 81

Go to My Computer, then follow the file path you specified during installation to find the
Gemini Commander.exe file, which will open the program. The default installation path  for
Windows XP and 32-bit versions of Windows Vista and Windows 7 is C:\Program Files
\Gemini Commander. The default installation path for 64-bit versions of Windows Vista and
Windows 7 is C:\Program Files (x86)\Gemini Commander.
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Getting Help

If you encounter any problems during connection, configuration, or operation, please contact
Optec Technical Support by telephone or email.

mailto:support@optecinc.com?subject=Help with FocusLynx
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Connecting To Your Gemini

Section 1.3.2 - Connecting To Your Gemini

NOTICE: Make sure that you have connected the hub's focuser port to the Gemini's focuser port
and the hub's rotator port to the Gemini's rotator port. Although it is difficult to damage the Gemini
by switching the lines it is best to avoid this problem. 

Once you have installed your Gemini Commander software, the next step is to connect your hub
to your computer. These instructions will help you connect over an RS-232 Serial connection
using the Serial-USB cable included with the Gemini controller hub. For instructions on
connecting and configuring over other types of connections, please consult the Configuring
Software section of the Gemini manual.

To establish a serial connection using Gemini Commander:

Plug In Your Gemini Hub - Plug the universal 12VDC power supply into a wall outlet using
a locally compatible power cord.  Insert the 2.5mm x 5.5mm plug into the 12VDC power port
on the Gemini control hub and move the slide switch up to turn on the Gemini hub.  The LED
power indicator will light after a few seconds to indicate the boot sequence was successful.  

Connect the Serial-USB Cable - For serial communication, connect the RJ12 plug into the
Gemini socket labeled "Serial" and connect the USB-A plug into an open USB port on the PC
computer.
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Go To The Setup Screen - Open Gemini Commander and go to the Tools menu. Choose
the Settings option. The setup screen will open, note that this screen is a separate client.
The Setup Screen will appear in the upper left screen - If not initially visible, check the task
bar for the second Gemini instance.   If you wish to leave the setup screen at any time
without changing any settings, click the OK button at the bottom of the window. 
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Connect To The Hub - For serial communication, select the Serial option in the
Connection Setup section and use the Com Port drop-down to select the appropriate
communications port.  This drop-down list will display only active serial ports so the virtual
com port (VCP) assigned to the Serial-USB cable should be easy to identify.  Next click the 
Connect button. If the LED indicator next to the Connect button does not light or if you
receive an error, try selecting a different serial port in the Com Port drop-down list. If you
encounter persistent problems determining which COM port to use, contact Optec Technical
Support for assistance. You will see the Firmware version update when the connection is
established. If you wish to connect via the Ethernet or WiFi check the network box and click
search network. After several seconds you should be able to select the Gemini's IP address
from the drop down box.

Adjust LED Brightness - if you find the focuser hub's power indication LED adversely
affects your night vision, you may adjust its brightness with the LED Brightness slider. The
range of brightness varies from left to right, starting with no light at all and moving to full
brightness. You have to be connected to adjust the LED brightness.
Configure the Focuser - In the Configure box click on Focuser. You should see this menu
appear:
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This will allow you to adjust many of the focuser's features. Several features are factory defaults
and can not be adjusted.

Configure the Rotator - In the Configure box click on Focuser. You should see this menu
appear:

This will allow you to adjust many of the rotators features. Several features are factory defaults
and can not be adjusted.

Connect To The Hub Via WIFI - Connect your computer to the GeminiConfig WiFi
network that is auto-generated by the hub. In Gemini Commander, verify that the 
Connection Setup selection is set to WiFi and the IP Address setting has been auto-filled
(if it has not, then click the Refresh IP's button to try again, then click the Connect button.  If
the IP address that is auto-filled is incorrect, contact Optec for support.

-OR-
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Connect To The Hub Manually - Connect to the hub via serial or Ethernet, then click the
Wireless Lan button. Current WiFi configuration information will be displayed. If at any time,
you wish to restore the hub's WiFi settings to default, click the Restore button.

 
 Enter A New Configuration - Enter a network name, security type, security key
(if necessary), and WEP Key Index (if necessary) that matches the Wi-Fi network to
which you want to connect.

 
Confirm Your Changes - Click the Apply New Settings button to connect to the
new network. Allow one to two minutes for the hub to reconnect. A message will be
displayed to confirm your changes. Click the Close button to exit this window.

 
Connect To The Hub - Connect your computer to the Wi-Fi network that you
entered information for above. Verify that the Connection Setup selection is set to
WiFi and the IP Address setting has been auto-filled (if it has not, then click the
Refresh IP's button to try again, then click the Connect button.  If the IP address that
is auto-filled is incorrect, contact Optec for support.

 

Confirm Connection - The red LED simulation should turn on, indicating that the connection
has been established.
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Completing The Configuration

Section 1.3.3 - Completing A Serial Configuration

Having successfully installed the Gemini software and connected to your hub, you can now use
the following instructions to complete a serial configuration.  Alternatively, you may use any of the
other connectivity options detailed in the Configuring Software section of the Gemini manual. 

To complete a serial configuration for the focuser:

Set Nickname -  You may set the nickname by entering any description into the Nickname
text box.

 
Immediate Temperature Compensation - If you want to begin temperature compensation
immediately upon opening Gemini Commander, check the Temperature Compensation At
Start checkbox.

 
Enable Backlash Compensation - If your focuser has a noticeable amount of backlash,
check the Backlash Compensation Enabled checkbox to enable compensation.

 
Set Backlash Steps - Enter a number of steps into the Backlash Comp. Steps text box to
adjust to the level of backlash compensation your focuser requires.   You may set the
number of steps to a maximum of 9999 steps in the OUT direction only.

 
Confirm Your Configuration - When you are finished, click the Ok button to save your
changes and return to the main Gemini Commander window.
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To complete a configuration for the rotator:

Set Nickname -  You may set the nickname by entering any description into the Nickname
text box.

 
Enable Backlash Compensation - If your focuser has a noticeable amount of backlash,
check the Backlash Compensation Enabled check-box to enable compensation.

 
Set Backlash Steps - Enter a number of steps into the Backlash Comp. Steps text box to
adjust to the level of backlash compensation your rotator requires.   You may set the number
of steps to a maximum of 9999 steps in the OUT direction only.

 
Confirm Your Configuration - When you are finished, click the Ok button to save your
changes and return to the main Gemini Commander window.

Congratulations! Your hub and focuser are now ready to use! You may use the current
configuration to connect or disconnect from a focuser by clicking the Connect or Disconnect
buttons in the Setup Window, the Connect or Disconnect buttons in the File menu of the main
window, or by clicking the LED above each focuser information display in the main window.
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Temperature Coefficients

Section 1.3.4 - Configuring Temperature Coefficients

While it is possible to manually calculate and configure the temperature coefficients for your
temperature compensating focuser, there is also a handy setup wizard available in the Gemini
Commander control program that will assist you in setting up your temperature coefficients.

Connect To Your Hub - Connect to the focuser hub in Gemini Commander via the method
described in the Connecting To Your Gemini portion of this Quick-Start Guide. 

 
Plug In Your Focuser And Temperature Probe - Ensure that both the focuser and its
temperature probe are properly connected.  In the Settings dialog box you may click
Focuser button and then the Temperature Compensation button to make changes. 
Accept the default temperature coefficients or change the Description and Coefficient if
you already know your system's unique temperature coefficient, then Apply Changes. 

Select the active Mode to be used when turning ON temperature compensation in the
Gemini Commander main window or when using other ASCOM applications.

Alternatively, you may choose to run the Temperature Compensation Wizard to determine
your optical system's unique temperature coefficient.
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Open The Temperature Compensation Wizard - Open Gemini Commander and go to
the File menu and select the Temp. Comp. Wizard option.
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Complete The Temperature Compensation Wizard - Follow the directions provided by
the wizard to calculate and save a temperature compensation coefficient as the
compensation mode of your choice.

Enable Temperature Compensation - When you return to the main Commander window,
make sure to enable temperature compensation by selecting On in the Temperature
Compensation section of the main window.  
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Configuring Software

Section 1.4 - Configuration Of The Gemini Focusing Rotator

The Gemini hub accepts three different forms of computer communication protocols and
connections: RS-232 for Serial-USB, Wired Cat 5 Ethernet, and WiFi wireless Ethernet (using
the optional WiFi Add-in Board). Consequently, there are a variety of ways to configure the
Gemini Commander software for use with a computer.  Each method works equally well for
controlling the hub, so the best choice is very much dependent upon the user's preference and
observatory local network configuration. 

Configuring A Connection Using Gemini Commander

Gemini Commander is an easy-to-use, all-in-one program for controlling your Gemini through the
hub. It can handle connections of all three types. Instructions for connecting with each type of
connection are given below:

Connecting to your Gemini

Configuring A Connection Using The Gemini Control Website

Another option for controlling the Gemini is to use the web-page that is automatically generated
by the Gemini on-board web server. This web-page is accessible whenever a Gemini hub is
connected to a computer by Ethernet or WiFi. As Gemini Commander is only compatible with
Windows systems, using the web-page is a much better option for Mac and Linux users.
Additionally, once the web-page is configured, owners of smart-phones may access this web-
page to, in essence, turn their phone into a hand controller! Instructions for connecting with
either connection option are given in detail below:

Web-page Ethernet Connection
 

Web-page WiFi Connection

Configuring A Direct Serial Connection Using A Serial Terminal Application

In addition to the options described above, commands may be sent to control the Gemini by
using the Optec Terminal Application or another a serial terminal application to directly send
commands to the hub over a serial connection. Instructions for connecting to the hub via a serial
terminal application are given in detail here:

Direct Serial Connection
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Webpage Ethernet

Section 1.4.1 - How To Configure A Web-Based Ethernet
Connection

NOTICE: Make sure that you have connected the hub's focuser port to the Gemini's focuser port
and the hub's rotator port to the Gemini's rotator port. Although it is difficult to damage the Gemini
by switching the lines it is best to avoid this problem.

As an alternative to the Gemini Commander control software, the Gemini hub can be controlled
via a web-page. This web-page can be accessed and configured through either an Ethernet
connection or via WiFi. To access and configure the web-page, follow these simple steps:

Power Up And Connect The Gemini - Ensure that the 12VDC power adapter is plugged
into both the Gemini and a power outlet, then flip the switch on the side of the focuser hub to
turn it on. A red LED should turn on to confirm that the focuser hub is now running. Ensure
that there is a valid Ethernet connection between the computer and the hub.

Go To The Web-page - Accessing the web-page works slightly differently depending on
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whether you are using a Windows machine or not.
 

Windows - Using any of the supported browsers listed in the System Requirements,
access the control website at gemini/focuser1.htm.

 
Non-Windows - First, find the IP address of your Gemini. You can find this by
checking the homepage of your router. The command line command arp -a will list all
IP addresses that your computer knows about on your network. If you are unsure
which IP belongs to your Gemini disconnect the Gemini, rerun the command then
reconnect it. Now, access the control website with any supported browsers by going
to [IP Address Here]/focuser1.htm. 

Congratulations! You are now ready to use the control website to control your Gemini. 

focuslynx/focuser1.htm


30 / 81

Webpage Wi-Fi

Section 1.4.2 - How To Configure A Web-Based WiFi
Connection

Note: To connect to the Gemini via WiFi, purchase of the WiFi Daughter Board is a necessity! If
you have not purchased this board, you must use another method to connect to the Gemini!
Additionally, your computer must be able to connect to WiFi networks!

As an alternative to the Gemini Commander control software, the Gemini hub can be controlled
via a web-page. This web-page can be accessed and configured through either an Ethernet
Connection or via WiFi. To access and configure the web-page, follow these simple steps:

Power Up The Gemini - Ensure that the 12VDC power adapter is plugged into both the
Gemini and a power outlet, then flip the switch on the side of the focuser hub to turn it on. A
red LED should turn on to confirm that the hub is now running. 

Note: There are several methods that can be used to connect to the board via WiFi. Please pick
ONE of the following options:

If The Hub Is Already Connected By Any Method In Gemini Commander - You may use
the WiFi Setup window in Gemini Commander to switch the hub  to a wireless connection
method. More details on this procedure can be found on the Gemini Commander WiFi page.

-OR-

If The Hub Is Already Connected Via Direct Serial Connection - You may use the WiFi
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information commands found in the Command List to switch the hub to a wireless
connection method. 

Set The Basics - At minimum, you will need to set the name and security type of
your network. 

 
Provide Security Information - If your network is not an open network, you will also
need to provide a pass-phrase.

Provide A WEP Index - If your network uses WEP security, you will also have to
provide a WEP Key Index.

Confirm Network Settings - When you have set all of this information, use the
Push Settings command to tell the hub to switch to the wireless connection.

-OR-

If The Hub Is Unconnected - When the Gemini is started, it will begin to generate its own
WiFi network that will allow you to connect to the web-page.

 
Connect To The Setup Network -  This setup network will be called GeminiConfig,
and you should connect your computer to it now. Note that the control website is the
only site that can be accessed on this network.

 

Go To The Web-page - Now you will be able to access the control website at
Gemini/focuser1.htm

focuslynxwifi/focuser1.htm


32 / 81

 
Begin Focusing or Swap To Your Own Network - If you just want to have quick
access to your device, you are all set!  However, if you want to be connected on a
secure network and/or have access to other web-pages, you can use this setup
network to swap your connection to any wireless network in the area.

     Note: The following instructions are only necessary if you want to switch to a new
WiFi network. 

Go To The Configuration Page - Once on the control website, click the Configure
link to go to the WiFi configuration page.

 

Find Your Network - Click the Scan For Wireless Networks button to search the
area for all available networks and click the one to which you wish to connect. The
focuser hub will begin connecting. You will be prompted for a security key if
necessary. The web-page will then change to one that gives instructions on finalizing
your connection.
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     -OR-
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Specify Your Network - Click the Other Network... button to enter information
about the network you want to connect to. 

Input Network Settings - You will need to input the network type, name,
and security type. 
Submit Your Settings - When you are finished, click the Join button to swap
to the new network. You will be prompted for a security key if necessary. The
webpage will then change to one that gives instructions on finalizing your
connection.

      

Go To The Web-page - Accessing the web-page works slightly differently depending on
whether you are using a Windows machine or not.

 
Windows - Using any of the supported browsers listed in the System Requirements,
access the control website at gemini/focuser1.htm.

 
Non-Windows - First, find the IP address of your Gemini. You can find this by
checking the homepage of your router. The command line command arp -a will list all
ips that your computer knows about on your network. If you are unsure which ip
belongs to your Gemini disconnect the Gemini, rerun the command then reconnect it.
Now, access the control website with any supported browsers by going to [IP
Address Here]/focuser1.htm. 

Congratulations! Your focuser hub is now configured to work over the WiFi connection of your
choice! This ability is not limited to regular computers. The control website has been designed to
accommodate Android and iPhone smart phones, so accessing the web-page with these

focuslynx/focuser1.htm


35 / 81

devices is now possible!
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Direct Serial Connection

Section 1.4.3 - How To Configure A Direct Serial Command
Connection

Install A Serial Terminal Application - In order to send direct serial commands, you need a
serial terminal application to send them. The Optec Terminal Application is available for
free download on the Optec website and requires no installation. Other similar applications
such as HyperTerminal are available for free download on the Internet. The following
instructions assume that you are using the Optec application, but the configuration for other
applications should work in a similar fashion. 

Configure Serial Connection Settings - To connect to the Gemini with the Optec Terminal
Application, ensure that the following configuration options are set correctly:

Port Number: Variable
Baud Rate: 115200

      For other serial terminal applications, you may also have to specify these options:

Parity: None
Byte Size: 8
Stop Bits: 1

The port number of your focuser hub is determined by which serial port on your computer
the hub is connected to. If you are not sure which COM port your focuser hub is plugged into,
guessing and checking among the available options should work, as there will be very few
COM ports on any given computer. If you encounter persistent problems determining which
COM port to use, contact Optec for assistance.

Power Up And Connect Your Gemini - Before the next step, ensure that the 12VDC power
adapter is plugged into both the Gemini and a power outlet, then flip the switch on the side of
the hub to turn it on. A red LED should turn on to confirm that the focuser hub is now running.
Also ensure that your Gemini focuser hub is connected via RS-232 serial cable to your
computer. 
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Open Connection - Click the Connect button to open a connection to the device. When the
connection is open, the same button will be labeled Disconnect and will disconnect you from
the focuser hub when clicked.

Congratulations! Your hub is ready to receive focuser commands directly from your terminal
application! 
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Uninstalling Software

Section 1.5 - Gemini Commander Uninstallation Instructions

To uninstall the Gemini Commander control software, please follow these steps:

Go to the Start menu, and click Control Panel.

Within the control panel, if you are running Windows 7 or Vista, click the Uninstall option to
choose a program to uninstall. If you are running Windows XP, click Add/Remove
Programs to choose a program to uninstall.

 
Scroll through the list of programs to find Gemini Software. If you are running Windows 7 or
Vista, click Uninstall to open the uninstaller. If you are running Windows XP, click Change/
Remove to open the uninstaller.

Follow the prompts provided to uninstall Gemini Commander.

When the uninstaller has finished, Gemini Commander and the Gemini software drivers will have
been removed from your computer.
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Operation

Chapter 2: Operation Of Gemini Focusing Rotators

Gemini Commander - Operating the Gemini Commander software

Focus Presets And Offsets - How to add and remove focus offsets and presets

Sky PA Offsets - How to use the Sky PA Offset function

Accessories - Operating a focuser with Optec accessory items

Gemini Hand Control - Operating a focuser with the Gemini hand controller
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Gemini Commander

Section 2.1 - Operating Gemini Commander

The Gemini Commander control software is the easiest and most user-friendly method for
controlling a  Gemini focuser hub with a Windows computer. Once you have installed Gemini
Commander and configured it for connection with a Gemini, you can use the following
instructions to control your Gemini:

Controlling Your Hub

Plug In Your Gemini - Ensure that there is a valid connection between your Gemini hub and
one of the two ports on the Gemini. Make sure that you plug the Focuser into the Focuser
port and the Rotator into the Rotator port.
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Relative Move - The In and Out  and the Arrow buttons found below the position display on
the main Commander window can be used to move the focuser in the direction specified.
With each click, the focuser or rotator will move by the number of steps or degrees displayed
in the Increment text box.

Adjust Increment - To adjust the amount by which the Relative Move buttons moves a
device, enter a number (or use the up and down arrows) into the Increment text box that is
located between the buttons.

Absolute Move - To move the focuser to a specific location, use the Absolute Focus
Adjust or Absolute Angle Adjust text box located below the temperature compensation
toggle. Enter a number of steps into the text box, then click the Go To button to start 
moving. The number of steps must be between zero and the maximum number of steps for
your device (you can find this in your focuser's documentation).

Clicking on the Rotator Graphic will also cause an absolute move for the rotator.
 



43 / 81

Note:  With both relative and absolute moves, if you try to move beyond the physical limits of the
device the program will stop you from doing so to prevent you from damaging the System.

Centering - To move the focuser to the exact center of its travel, click the Center button.
The focuser will automatically begin moving.

Halting - To stop the device once it has begun moving, click the Halt button that is
immediately to the left of the position and temperature displays.

Temperature Compensation - You can use the Temperature Compensation buttons
located below the Relative Move buttons to turn temperature compensation on or off. Unless
you specify otherwise during focuser configuring, temperature compensation will be off by
default.

Homing - To Home a device select the device under the Home menu.

Absolute Angle Adjust - Moves the rotator to the target angle.

Park - Move the Gemini to the position defined by the Set Park button.
 

Changing Display Units

You can adjust the units of the position and temperature display for the simply by clicking the
respective quantity's display.

Position units can be switched between steps, microns and millimeters.

You can also switch the rotator from Degrees Minutes Seconds to decimal degrees.

Temperature units can be cycled between Celsius, Fahrenheit, and Kelvin. 

Adjusting The Display
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Using the View menu on the main Commander page, you can select what  information is visible
to you. You can click on each item to toggle its display on or off, and use the Show All selection
to return to the default setting of showing all possible items. 
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The Always On Top option will place the Gemini Commander window on top of all other
program windows you may have open, no matter which window is selected, so you can always
see your controls. 

Your view preferences will be saved, so you can close Gemini Commander and have the
same view settings applied the next time the program is opened.
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Focus Presets And Offsets

Section 2.1.1 - Setting/Removing Focus Presets And Offsets

Enabling Absolute Focus Presets and Relative Focus Offsets

Gemini Commander provides the option to establish Relative Focus Offsets and Absolute
Focus Presets to allow the user to have saved absolute positions and saved offset movements,
typically used with filter offsets.  By default, neither Relative Focus Offsets nor Absolute Focus
Presets are enabled.  To enable and work with Offsets/Presets you must enable the window
panel under the View menu by clicking Relative Focus Offsets and/or Absolute Focus
Presets.  A check-mark will appear next to the option and the window panel will be revealed. 
Some re-sizing of the Gemini Commander main form may be required.

Description of Absolute Focus Presets 

The purpose of the Absolute Focus Presets is to allow Absolute Focus Adjustments that are
used frequently to be saved as a shortcut.  For example, if the user has a preferred Park position
for the focuser a preset can be saved.  At the end of each evening's run, a simple click of the
radio button next to the Absolute Focus Preset named PARK will drive the focuser to the stored
position.  
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Description of Relative Focus Offsets

Unlike Absolute Focus Presets, Relative Focus Offset are not nearly as intuitive and can
present seemingly confusing behavior.  Relative Focus Offsets were included at the request of
several customers to allow filter focus offsets to be performed directly from Gemini
Commander.   Most image acquisition software applications such as Maxim D/L, TheSky X, and
many others provide similar functionality.  Review your acquisition software's description of
"Filter Focus Offsets" for a detailed description of the process.  In short, due to chromatic
aberrations in telescopes and refractive shifts due to different thickness filters, the best focus for
each color filter may lie at different focal planes.  A focuser can easily compensate for this filter
focal shift if the step position changes have been characterized and defined in advance. 
However, duplication of filter focus offsets between software packages is not recommended. 
Choose one software package to perform the offsets and stick with it exclusively.  

That being said, here is a description of the Relative Focus Offsets feature provided in Gemini
Commander as applied to Filter Focus Offsets.  The screen shot below shows an example of
preconfigured Relative Focus Offsets for the TCF-Lynx focusers and an arbitrary optical system.



48 / 81

 Assume the CLEAR filter focus position is our baseline and has an Offset of 0 steps.  The RED
filter has an Offset of +150 steps from Clear.  The GREEN filter has an Offset of +25 steps from
Clear, and the BLUE filter has an Offset of -75 steps from Clear.  All moves are relative to the
CLEAR focus position.  

Assume we start at Position 3500 and click the RED offset.  The focuser moves to 3500 plus
150 or 3650, as shown.  Clicking the GREEN offset will move to 3525 (3500 plus 25) and clicking
the BLUE offset will move to 3425 (3500 minus 75).  These moves are relative to our original
starting point and NOT the current position.  This procedure is straight-forward until we introduce
additional moves.

If we make a Relative move from any of these positions of, say 250 steps, then the new baseline
will be 3500 plus 250, or 3750 steps.  All offsets will now be based upon this new baseline - the
CLEAR filter in our example below.  In this example, clicking the CLEAR offset will move
immediately to 3750, the RED offset will move to 3750 plus 150, or 3900.  Similarly, clicking the
GREEN offset will move to 3750 plus 25, or 3775, and clicking the BLUE offset will move to 3750
minus 75, or 3675.

Turning on Temperature Compensation at this point will move the focuser in accordance with
the TC, or temperature coefficient, and all moves will be with respect to the baseline, or CLEAR
filter position in our example.  Again, this can be confusing to watch and understand but if you
think about it in terms of the baseline position it will make sense.  Contact Optec Technical
Support for clarification or additional explanation.

Setting Offsets

The purpose of the focus offset is to accommodate customers who are using the Gemini in
conjunction with one or more filter wheels. When changing from one filter to another, a focus
change is often required because the optical system does not always focus all wavelengths at
the same focal plane.  A small offset can be entered for each filter used.  

support@optecinc.com
support@optecinc.com
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Open The Add Offsets/Presets Window - On the Gemini Commander main window, right-
click anywhere within the Relative Focus Offsets list at the bottom of the window. Select
the Add Offset(s) option. You may add as many offsets as you like from the same window.

 
Add A Name - Give the offset a name by filling in the Offset Name text box. 

 
Add A Step Number - Specify the number of steps associated with the offset by filling in the
Steps text box.  For Offsets a positive Steps: value will move the focuser Out while a
negative Steps: value will move the focuser In.

 
Save Your Offset - Click the Add Offset button to add your offset. The offset should appear
in the Relative Focus Offsets list on the Commander main window.

Setting Presets

The purpose of these presets is to provide the user the ability to quickly change focus to a
specific stored position. For example, if you know that your optical system focuses somewhere
near 1000 steps, you may want to create an absolute focus preset at 1000. With such a preset,
you may be able to shorten the time of a focusing routine by quickly moving close to your focus
point before beginning the routine.
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Open The Add Offsets/Presets Window - On the Gemini Commander main window, right-
click anywhere within the Absolute Focus Presets list at the bottom of the window. Select
the Add Preset(s) option.  You may add as many presets as you like from this window.

 
Add A Name - Give the preset a name by filling in the Preset Name text box. 

 
Add A Step Number - Specify the absolute position associated with the preset by filling in
the Position text box. 

 
Save Your Preset - Click the Add Preset button to add your preset. The preset should
appear in the Absolute Focus Presets list on the Commander main window.

Removing Offsets 

Open The Remove Offsets/Presets Window - On the Gemini Commander main window,
right-click anywhere within the Relative Focus Offsets list at the bottom of the window.
Select the Remove Offset(s) option.

 
 Select The Offsets - Select the offset you wish to remove by clicking on it in the Available
Offsets list. Use Ctrl+Click to select multiple offsets from the list.

 
Remove The Offsets - Remove the selected offsets by clicking the Remove Selected
button.

Removing Presets
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Open The Remove Offsets/Presets Window - On the Gemini Commander main window,
right-click anywhere within the Absolute Focus Presets list at the bottom of the window.
Select the Remove Preset(s) option.

 
 Select The Presets - Select the preset you wish to remove by clicking on it in the
Available Presets list. Use Ctrl+Click to select multiple presets from the list.

Remove The Presets - Remove the selected presets by clicking the Remove Selected
button.
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Sky PA Offsets

Section 2.1.2 - Sky PA Offsets

Changeing the Sky PA Offset

Sky Position Angle - The Sky PA display box indicates the rotator's current Sky Position
Angle. The Sky PA can be changed by clicking the Set Current Sky PA... button. This will
open a dialog that will let you enter a new Sky PA. When you are finished, click Ok.  To
match the Sky PA to the actual Sky Position Angle take an image and perform a plate-solve.
 With a successful solve the Position Angle (sometimes referred to as Roll Angle) will be
displayed in the solution and can be entered into the Set Sky PA dialog box. (see example
screen below). To change the Sky PA Offset click on the Set Sky PA button and enter the
actual Sky PA and click OK.

This will map the instrumental PA to The Sky PA. The offset (as of software version 1.0.2) is
stored at the driver level and is sent to all ASCOM clients, allowing the sky PA to be set once for
all connected clients.

This offset is sent to all connected clients. This means that you can adjust the Sky PA
here and keep all clients in sync.
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Accessories

Section 2.4 - Gemini Accessories

In addition to control with a computer or smartphone, the Gemini can be controlled via a Hand
Controller.

Gemini Hand Control 
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Gemini Hand Control

Section 2.4.1 - Using The Gemini Hand Control

The Gemini Hand Control is optionally available to allow control of the Gemini controller while at
the telescope. The Hand Control provides a digital read-out and IN and OUT focus functionality. 
A MODE button is also provided to switch between the Focuser and the Rotator.  Pressing the
MODE button will toggle between a splash screen with the hand control firmware version
number, Focuser, Rotator, and the Home screen.  The home mode allows you to rehome the
focuser or the rotator.

The Hand Control should be connected to the Hand Controller port of the Gemini control box
using either the short or long 4-pin coiled cable included with the package.  Most any telephone
handset cable will work but a ferrite core choke may be required for longer cables if the "Waiting
for Data" error appears and persists.  
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The Hand Control can be plugged in or disconnected anytime without concern about damaging
either the Gemini control box or the Hand Control.  Using a serial protocol, the PIC in the Hand
Control communicates with the main PIC in the Gemini box receiving position updates and
sending new position requests.  All position changes are instantly communicated to the control
PC so that each display system is simultaneously updated with the current focuser position.
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FAQ & Troubleshooting

Chapter 3: Gemini FAQ & Troubleshooting

Please consult the topics in this chapter for answers to some of the most frequently asked
questions about the Gemini focuser hub, as well as technical assistance and solutions to
common problems you may experience with the Gemini.

Hub Connection Issues - How to solve issues that may arise while trying to maintain a
connection to your Gemini focuser hub

 
Configuring USB Converters - How to configure and troubleshoot your USB-to-Serial
Converter

 
HTML Help Viewer Display Issues - How to ensure that you can use the in-program Gemini
Commander help file.

Updating Firmware - How to update the software that runs on your focuser hub.
 

Updating Gemini Commander - How to update the computer software that controls the
focuser hub.

If your problem is not solved within this help file, please contact Optec directly and we
will be happy to assist you.

Contacting Optec Technical Support - How to ensure when contacting Optec for support that
your problem is resolved as quickly as possible.

 
Accessing The Event Logger - How to configure, retrieve, and view Gemini
Commander event logs.
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Hub Connection Issues

Section 3.1 - Gemini Hub Connection Issues

If you experience issues getting connected or staying connected to your Gemini focuser hub, the
following techniques may assist you in solving your connection problems:

Check Your Physical Connections - The first step to diagnose any connection problem is
to check all connections. 

Ensure that the 12VDC power adapter included with your Gemini is plugged into both
a wall outlet and the hub and that the hub is turned on. 

If you are attempting to connect via serial or ethernet, ensure that the connection
cable is properly plugged into both the hub and your computer. 

If you are attempting to connect via Wi-Fi, ensure that your computer has a strong
connection to the wireless network. Also note that unless you have purchased the Wi-
Fi Daughter Board upgrade, you will not be able to connect via Wi-Fi.

 
Check Your Connection Settings - Once all physical connections have been verified, the
next most likely issue is with the connection configurations in your control software.

 
If you are attempting to connect via serial cable, ensure that your software is set to
connect using the same port number that the focuser hub is plugged into. This port
number is dependent on the specific serial plug that your cable is using. Also, if you
are using a program other than Gemini Commander, ensure that the baud rate is set
to 115200.

 
If you attempting to connect via ethernet cable or Wi-Fi, ensure that you are
connecting to the correct IP Address. Waiting a few minutes since your last
connection attempt and clicking the Refresh IPs button on the Setup dialog of Gemini
Commander should solve this problem.

Additionally, if you are attempting to connect via Wi-Fi, ensure that you are connected
to the same network that the Gemini hub is configured for. If you have not specifically
defined another network for the hub to connect to, the network you must use is called 
GeminiConfig.

 
If you are using a USB-to-Serial Port Converter, ensure that it is configured correctly
by following the instructions in the Configuring USB Converters section of this
manual.

 
Try Another Connection Method - If all else fails and you find yourself unable to connect to
your hub using your preferred method, we suggest attempting to use one of the many other
methods (serial instead of ethernet, webpage Wi-Fi instead of Gemini Commander Wi-Fi,
etc.) described in the Configuring Software section of this manual to connect to your
focuser. Whether trying a new method works or not, you will have gained valuable
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knowledge. If you succeed in maintaining a connection with another method, then you know
the source of your problem. If not, you know that the cause of this problem is not specific to a
connection method and is more likely systemic in nature.

If your problem is not resolved by following these steps, then it is highly recommend that you 
Contact Optec directly for assistance.

http://www.optecinc.com/astronomy/support.htm
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Configuring USB Converters

Section 3.1.1 - Configuring USB-To-Serial Converters

The Gemini package includes a special USB/Serial Cable designed by Optec to work with
nearly all Optec serial devices.  The device used in the cable is based on the FTDI chipset.  Most
current operating systems include native drivers for these USB-to-serial converter devices. 
Windows 7 and higher will automatically load the proper device driver upon initial use.  The very
latest drivers for Windows and Mac are available directly from the Optec and FTDI websites.  

Generally, the Gemini Commander software will list only valid and available COM ports in the
Connection Setup section of the Focuser Setup dialog boxes.  However, if you are unsure which
COM port has been assigned to your USB/Serial cable or USB-to-Serial converter, you may
need to check the Device Manager in Windows. The instructions for Windows XP below provide
the easiest way to install the converter drivers and configure the USB-to-Serial port converter
when using an older operating system.  Windows 7 and newer operating systems do not
generally require the steps below, but will quickly locate and load the proper device driver when
plugging the USB/Serial Cable into a USB port. 

To display the Device Manager in Windows, click Control Panel on the Start menu, or right-
click on the My Computer icon and select Manage. Select Device Manager under System
Tools.

Remove Old Drivers - Before plugging your new converter into your computer, make sure
that any existing old drivers for the FTDI chips set have been removed. Do this by going to
the Add/Remove Programs in the Control Panel and find any listing of FTDI drivers and
remove it. If you have any older USB-to-Serial Converters using the FTDI chip set, you can
remove them now.

 
Download And Install New Drivers - From the Optec Install disk or from the Optec
Downloads page, at download and run the FTDI driver executable setup program. This setup
program is compatible with Windows XP, Vista, and 7. You will not see any message if the
program loads successfully.

 
Plug In Your Converter - After running the setup program, you can now plug in one of your
FTDI chip set USB-to-Serial converters. 

 
Open Device Manager - To find the COM number that was selected for each USB-to-Serial
converter, go to your Device Manager by clicking the Control Panel option on the Start
menu, and selecting Hardware and Sound, followed by Devices and Printers -> Device
Manager.

 

http://www.optecinc.com/astronomy/downloads/usb-to-serial.htm
http://www.optecinc.com/astronomy/downloads/usb-to-serial.htm
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Find The Converter Port - Browse the list of devices to see the COM port number listed
under Ports (COM & LPT). In the diagram above, the USB-to-Serial Converter is using port
COM7. You can then plug your other converters in one at a time to see which COM numbers
have been selected for those.

 
Additional Modification May Be Necessary - If you purchased your converter from Optec
before July 2007, you may have to modify an additional setting. If you do not see the COM
port number in the Device Manager screen as above, but do see messages that indicated
that the USB-to-Serial converter is installed and ready, then right-click the USB Serial Port
device and select Properties. 
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Check The Checkbox - Select the Advanced tab in the properties window and check the
Load VCP box. Unplug the USB-to-Serial converter and then plug it back in. You should see
the COM port number appear under Ports. This will affect all converters connected to the
computer.
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HTML Help Viewer Display Issues

Section 3.2 - HTML Help Viewer Display Issues

If the Help Viewer used by Gemini Commander to view this help file displays an error message
saying either : "This action has been canceled or "The page cannot be displayed", thus forcing
you to view this help file via the Optec website, the following solution may help you resolve the
issue:

 Make A Local Copy - This help viewer will only work when opened from your computer's
local drive(s) (i.e. the C:\ Drive as opposed to a network path or mapped network drive). Find
the Gemini.chm file in your Gemini Commander installation and open it from a local drive.

 
If this does not work, your best solution is to simply continue using the Web-based help file that,
since you are reading this article, you are presumably already using.
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Updating Firmware

Section 3.3 - Updating Firmware

Firmware, as differentiated from software, is the set of programs loaded directly onto the Gemini
focuser hub's internal microprocessor in order to enable the hub to perform all of the functions
that it needs to perform.

In the past, upgrading most focusers, cameras, or other instruments with new firmware would
necessitate the expense and inconvenience of shipping the device back to the manufacturer and
waiting several days for it to be returned. However, the  Gemini eliminates this hassle by allowing
you to upgrade your firmware directly through the Gemini Commander control software.

WARNING! If you have recently updated your Gemini focuser hub firmware, we highly
recommend updating your software as well to ensure that your Gemini works properly.

To upgrade your firmware:

Connect Your Hub - Ensure that your Gemini focuser hub is connected via an RS-232
Serial connection.

 
Open The Firmware Upgrade Wizard - In Gemini Commander, go to the File menu and
select the Upgrade Firmware option.
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Check For A New Version - Using the Current Firmware Version and New Firmware
Version displays, determine if there is a newer firmware version available for download. If
not, click the Close button to return to the main Gemini Commander window

 
Download New Firmware - If a newer firmware version is available, you may download it in
one of two ways:

Auto-Download New Firmware -  Click the Auto Download button to automatically
download and save your new firmware. In this case, the Hex File Location will be
automatically filled in.

-OR-

Manually Download New Firmware - You may manually download the newest
firmware version from the Optec website. In this case, you must also manually select
the Hex File Location (the location of your download).

Upload Your Firmware - Once your firmware is downloaded, click the Upload Now button
to upload the new firmware to your focuser hub.

Factory Reset - The factory reset button will reset the Gemini's internal settings to their
factory defaults. 
 
Return To The Main Window - When you are finished uploading, click the Close button to
return to the main Gemini Commander window. 
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Updating Gemini Commander

Section 3.4 - Updating Gemini Software

In order to ensure the best possible experience with your Gemini, you should do your best to
keep your Gemini Commander software up to date. To do this, you can either:

Go To The Optec Website - We will always make the latest version of Gemini Commander
and its associated drivers available for download on our Downloads page.

-OR-

 

http://www.optecinc.com/astronomy/downloads/index.htm
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Check For Updates - Within Gemini Commander, access the Help menu and click the
Check For Updates option to determine if you need updates. If there is a newer version of
the Gemini software package available, you may choose to download and install it or not.
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Contacting Optec Technical Support

Section 3.5 - Contacting Optec Technical Support

If you encounter any problems, errors, or questions about using the Gemini focuser hub that are
not addressed by this owner's manual, the recommended next step is to contact Optec
Technical Support for assistance.

However, providing certain resources when contacting Optec will greatly increase the speed and
completeness with which your problem is solved. When using email, these resources should be
included in text or spreadsheet files attached to the email. When contacting Optec by phone,
simply have the documents available for ready access, as our technical support team may need
you to refer to them. The resources you will need are as follows:

Description of Your Problem - Naturally, to solve a problem, Optec tech support must
know what the symptoms of the problem are.

 
How The Problem Occurs - If there is a specific procedure required for the problem to
appear, make a note of the steps for doing so.

 
Text Of Your Error - If your problem is related to an error message received in Gemini
Commander, you should retrieve a verbatim copy of the error message.

 
Error Logs - If your problem is related to Gemini Commander, you should retrieve your Error
Logs as directed in the Accessing The Event Logger section of the manual.

Hub Firmware Version - The firmware version number can be found by opening the
Firmware Upgrade Assistant in Gemini Commander.

 

http://www.optecinc.com/astronomy/support.htm
http://www.optecinc.com/astronomy/support.htm
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Accessing The Event Logger

Section 3.5.1 - Accessing And Configuring The Gemini
Commander Event Logger

While using Gemini Commander, if the program encounters any sort of problem, it will notify you
with an error message describing the problem. If this problem is consistently and preventing you
from using the program the way you need to use it, we highly recommend contacting Optec
Technical Support for assistance.

Gemini Commander has been programmed with the capability to log every major event that
occurs during normal program operations, as well as the full details of every error that is capable
of occurring.

When preparing to contact Optec for support, having your Gemini Commander error log at the
ready and, if possible, sending that log to Optec can greatly increase our ability to solve your
your problem quickly and completely.

If you are contacting Optec for support, we also recommend following the other guidelines
outlined in the Contacting Optec Technical Support section of this manual. 

Configuring Event Logging

Accessing Event Logs

Events logged by the event logger are stored in the Windows Event Viewer utility.

To access Gemini event logs in the event viewer:

http://www.optecinc.com/astronomy/support.htm
http://www.optecinc.com/astronomy/support.htm
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Open Event Viewer - Windows Vista and 7 users can find the Event Viewer can be found
by searching in the Start menu for Event Viewer. Windows XP users must go to

 

Open Application Logs - On the left side of the viewer, a listing of all classes of events can
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be found. Click the Applications And Services Logs folder to open it.
 

Find Gemini Logs - In this folder, the Gemini Commander event log can be found under the
title Optec Gemini Log. Click on this log to open it.

 
View Events - Now, the full list of Gemini Commander events is viewable in the center
portion of the Event Viewer window. By default, the events are organized chronologically from
newest to oldest.

Saving Event Logs

Open The Event Viewer - Follow the previously described steps to open your Windows
Event Viewer and access the Gemini event log.

 

Save Events - Click the Save All Events As... button on the right side of the Event Viewer
to open a Save As dialog.

 

Save Events As A CSV - Using the Save As Type drop-down selection, choose the .csv
file extension. Choose a location to save the event log, and click Save to save it.
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Reference

Chapter 4: Gemini Reference

System Requirements - Required software and hardware for use of Gemini Commander and
the Gemini control website.

Hardware - Physical characteristics the Gemini focuser hub.

Command List - Listing of commands usable to directly communicate with the Gemini via a
serial connection.

 
Error List - Listing of errors that may be returned during direct serial communication.
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System Requirements

Section 4.1 - System Requirements

Gemini Commander 

In order to use the Gemini Commander control software, you will need the following software
installed on your system:

Ø Windows XP, Vista, Windows 7, Windows 8/8.1 or Windows 1

Ø ASCOM Platform 6.1 SP1 or later

Ø Microsoft .NET Framework 3.5 or later

Gemini Commander is a very lightweight program, so if your computer meets the minimum
system requirements for the software listed above, you should have no problem using Gemini
Commander.

Gemini Commander requires less than 5 MB of hard drive space. 

If you are unsure of whether you have the correct .NET Framework and/or ASCOM Platform
installed, simply run the installer for Gemini Commander. The installer will automatically search
your system for the required components and provide a link where you can download any that
are missing.

Control Website

To run the web page-based controls for the Gemini hub, all you need is an updated version of
one of the following supported browsers and a wireless or wired Ethernet connection to the hub.

The Gemini control website is supported on the following browsers:

Ø Internet Explorer

Ø Mozilla Firefox

Ø Google Chrome

Ø Safari (in both Mac OS X and iOS)

Ø Opera

Ø Android Browser

Ø iPhone Browser
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Power Connection

The Gemini focuser hub requires 12VDC to function properly. A suitable power power supply is
provided with every controller purchase. Please contact Optec, Inc in the event that you require a
replacement power supply. Using non Optec power supplies may cause damage to you unit.

Data Connections

There are three options for establishing the data communication link between your PC and the
Gemini hub: standard RS-232 serial, wired Ethernet, and wireless Ethernet via Wi-Fi (requires
purchase of the Wi-Fi optional board). See the Hardware reference for details.
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Hardware

Section 4.2 - Gemini Hardware

The Gemini hardware is simply designed and straightforward to use. The Gemini Hub box has
reserved one end exclusively for control connections and the opposite end reserved entirely for
device connections.

Dimensions

5.01 x 3.21 x 1.05 inches
 

12.73 x 8.15 x 2.67 cm
 
Device Connections

Focuser - Allows connection with a CAT-5E Ethernet cable.
 

Rotator - Allows connection with a CAT-5E Ethernet cable.

Control Connections

12VDC - Power connection for the Gemini. Connect your included 12VDC power adapter
here.

 
Network - Allows connection with a standard CAT-5E Ethernet cable (not included) to a
computer. This allows Gemini Commander or Webpage control.

Hand Control - Allows connection via RS-232 serial cable to the soon-to-be-released
Gemini Hand Controller, allowing portable hand-held control.

 
Serial - Allows connection via RS-232 serial cable to a computer. This allows Gemini
Commander or Direct Command control.

Microprocessors

Main Board - Microchip PIC24HJ128GP 204-I/PT
 

Wi-Fi Daughter Board - Microchip PIC24HJ128GP 202-I/SP
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Command List

Section 4.4 - Command List

Ø See the documentation on the Optec Website.
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Error List

Section 4.5 - Error List

Ø See the documentation on the Optec Website.



79 / 81



80 / 81

Additional Resources

Chapter 5: Additional Resources

There are many resources on the Internet to help you use the Gemini focuser hub. We
recommend visiting the Optec website first.

If you are unable to connect to the Internet, or you have any other questions at all, please feel
free to contact Optec Support by telephone at: 

Optec Support: 616-897-9351

http://www.optecinc.com/
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